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CORNELL HOSPITALITY TOOL

Instructions for the Restaurant
Reservations Optimization Tool
by Gary A. Thompson

EXECUTIVE SUMMARY

T

he purpose of this tool is to determine the best mix of tables in a restaurant, while simultaneously
determining which reservations should be accepted from forecasted demand. A key parameter in
the tool is the degree to which average dining durations are inflated. The tool user selects this
inflation factor according to expectations regarding the extent to which parties will exceed the
anticipated average dining time. Lower inflation factors result in more revenue, because more reservations
are accepted, but also come with lower service levels, meaning more customers will need to wait for a table.
Based on the user inputs, the tool, which uses the Solver add-in for Microsoft Excel, returns the optimum
table mix for the greatest revenue.
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CORNELL HOSPITALITY TOOL

Instructions for the Restaurant Reservations
Optimization Tool
by Gary A. Thompson

I

n a 2015 paper, I presented and evaluated ten models for restaurant reservations. In the analysis, I
examined two types of models. In one type, reservations were tied to specific tables, while in the
other, reservations were pooled for like-size tables. The models all optimized both the mix of tables
in the restaurant simultaneously with the set of reservations open to customers. Of the ten models,
seven defined the efficient tradeoff curve between revenue and customer service, and five of those seven
superior models were pooled-table models. As a result, I have designed this tool to implement the simplest of
the pooled-table models that I tested. In this document I describe the components of the tool, explain how
to use the tool by presenting a practical example of how to use it, and present a simple example of the
optimization model behind the tool. I close with some extensions to the tool.
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Exhibit 1

Party size-related information
Party Size

1

2

3

4

5

6

7

8

Party Value ($)

25.80

48.77

69.86

88.90

105.19

120.56

133.13

144.95

Average Duration
(hours:minutes)

0:42

0:54

0:59

1:08

1:14

1:19

1:24

1:38

Exhibit 2

Demand forecasts by party size and time period on Friday
Party Size:

1

2

3

4

5

6

7

8

6:00

2

4

2

3

2

1

1

1

6:15

2

4

2

3

2

1

1

1

6:30

2

5

2

3

2

1

1

1

6:45

2

5

2

3

2

1

1

1

7:00

3

5

2

3

2

2

1

1

7:15

3

5

2

3

2

2

1

1

7:30

2

5

2

3

2

1

1

1

7:45

2

4

2

3

2

1

1

1

Exhibit 3

Demand forecasts by party size and time period on
Saturday
Party Size:

1

2

3

4

5

6

7

8

6:00

3

6

2

4

1

1

1

0

6:15

2

4

2

3

2

1

0

1

6:30

2

5

3

3

2

0

0

1

6:45

4

5

2

4

1

1

1

0

7:00

3

6

1

3

2

2

0

1

7:15

3

5

2

3

1

1

1

1

7:30

4

6

2

4

2

1

0

1

7:45

3

4

2

3

1

1

1

0

A Practical Example of the Use of the Tool
For the purposes of our example, say that a restaurant has 3,200
square feet available for seating, including access. The restaurant tends to fill only on Friday and Saturday evenings, and the
restaurant manager is trying to decide whether to reconfigure
the table mix between Friday and Saturday, or go with the same
mix both days. The number of seats and square footage require-

4

ments for the tables are as follows: 2 seats, 35 square feet; 4 seats,
55 square feet; 6 seats, 75 square feet; and 8 seats, 95 square feet,
including access. Party values and durations by party size are
given in Exhibit 1. The current forecasts of customer demand
for reservations, by time period, for Fridays and Saturdays are
given in Exhibits 2 and 3.
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Exhibit 4

A summary of the revenue from the daily optimized table and reservations mixes
Table Mix (#2-tops, #4-tops, #6-tops, # 8-tops)

Revenue on Friday

Revenue on Saturday Total Revenue

Best on Friday (9/19/13/8)

$7,293.84

$7,205.61

$14,499.45

Best on Saturday (16/24/10/6)

$7,242.08

$7,301.44

$14,543.52

Best for Average of Friday and Saturday Demand
(18/20/12/6)

$7,270.56

$7,272.80

$14,543.36

Exhibit 5

Exhibit 6

Screen shot of
the Legend

Round-up and reservation
times definition

Using the Tool
The tool is based on a component of Microsoft’s Excel spreadsheet called Solver. The information provided below describes
the components of the tool, using a number of screen shots.
Solver’s size limitations mean that the tool is as big as it possibly
can be, with 8 reservation time slots, 8 party sizes, and 4 table
sizes. Given those relatively small numbers, I should note that
Solver upgrades are available for a fee (from Frontline Systems),
which would allow you to create bigger versions of this model.
Guide to the tool components. A screen shot of the
legend is shown in Exhibit 5. The components are:
• Inputs—the data items you need to provide; specific
inputs will be different for various restaurants, and all
other items are determined by the tool;
• Decisions—what the tool is changing, in this case the
mix of tables and the reservations accepted;
• Objective—The objective of the tool is to maximize
revenue or contribution; and
• Key outputs—revenue (or contribution), estimated
service level, and reservations accepted. Decision values
should also be considered as key outputs.
Round-up and reservation times. A screen shot of
the round-up and reservation times is shown in Exhibit 6.

The tool can yield the revenue maximizing table mix and
mix of reservations accepted. As reported in Exhibit 4, the
table mix that gives the best results on Friday yields $7,293.84
revenue on Friday and $7,205.61 on Saturday. The mix that
gives the best result on Saturday yields comparable values of
$7,242.08 on Friday and $7,301.44 on Saturday. So, the best
stable mix—Saturday’s—yields a total revenue for the two days
of $14,543.52, while switching to each day’s best mix yields
a total of $14,595.28, or an increase of $51.76. Clearly, then,
switching would depend on whether the tables themselves can
be reconfigured from one night to the other and also on the effort required to reconfigure the restaurant.

• Round-up is a parameter the user selects that inflates
the mean dining times, to give a cushion against parties
that take longer than average. The larger the round-up
value, the lower the revenue, but the better the level of
service. Based on the value you select, you will see an
estimated service level. For details on the origin of those
numbers, please see my working paper, “A Simple Yet
Practical Model for Optimizing Restaurant Reservations,” which I will provide on request.
• Reservation time is the time of the reservation. Note
that you only need to specify the first time and the others will update automatically. The tool is built on the
assumption that the reservation times are in 15-minute
increments.
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Exhibit 7

Party-specific information

Party-specific Information
The tool assumes that the party sizes range from 1 to 8 people.
The party-specific information in the tool is shown in Exhibit 7
and described below.
• Party value is the average value (revenue or contribution) of parties of that size.
• Duration (in minutes) is the average duration, in
minutes, of parties of that size.
• Duration in periods is the number of 15-minute
periods that will be allocated for the party. It is based on
the duration and the round-up parameter.

6

• Demand forecasts must be provided by reservation
time and party size. These are for a specific day.
• Total is the total number of reservations accepted for
that size party.
• Wait time limit is used in estimating the percentage
of parties that wait for a table.
• Estimated service level is the estimated percentage of parties that will wait longer than the specified
limit for their table.
• Total value is the estimated value of the tool’s recommended table mix and reservations accepted.

The Center for Hospitality Research • Cornell University

Table-specific Information
Note that the tool assumes the use of
2-tops, 4-tops, 6-tops, and 8-tops only.
Table-specific information is shown in
Exhibit 8, as follows:

Exhibit 8

Table-specific information

• Number is the number of each
size table recommended by the tool.
• Space/Table, which is a user
input, is the space required for a
table with the specified number of
seats. It should include an allowance
for access.
• Space used is the total space used
with the recommended table mix.
• Space available, another user
input, is the total space available for
tables, including access.
• Tables used by period is
determined based on the reservations accepted. It is used to ensure
no more tables are in use than the
recommended mix allows.
• Minimum #, an input, is the
minimum allowed number of each
size table.
• Maximum #, an input, is the maximum allowed number
of each size table.
Note: If you want to optimize the reservations using an existing
mix of tables, set the Minimum # and Maximum # for each
size table to the number of tables you have of that size.

Exhibit 9

Determining whether Solver is available



Solving the Tool
Follow the steps below to solve the tool:
1. To use the tool, you will need Excel’s Solver add-in. To
see whether Solver is enabled, in Excel for Windows, go
to the “Data” tab and look at the right to see whether
Solver is there, as shown in Exhibit 9. If you see Solver,
skip to step 3, otherwise, continue with step 2.
2. To install Solver, use the File>Options>Add-Ins menu
choices, then click the Go... button by Manage, Excel
Add-ins, and make sure Solver is checked. Once Solver
is installed, you will see it on the Data tab, as shown in
the screen shot. If you have difficulty, search Help in
Excel for Solver, for instructions specific to your version
of Excel. Once Solver is available, continue with step 3.

Exhibit 10

Click-to-solve button

3. If you are using a PC, you should be able to solve the tool
by clicking the Click to Solve button, shown in Exhibit
10. If you are using a Mac, or the button does not work
for you and you are using a PC, continue with step 4.
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Exhibit 11

Reservations accepted by party size and table-size assigned

4. If you are using a Mac, or you are using a PC and the button does not work for you, you will need to run Solver
manually. To do this, select the Data tab, click the Solver
button, and then click the Solve button.
Note: Changing your data inputs does not automatically change
the tool’s recommendations. After changing data you need to
Solve it again.

8

Reservations Accepted, by Party Size and Table
Assigned
The Reservations Accepted and Seated in Tables, which is the
key output of the tool, is shown in Exhibit 11. This information
shows which reservations are accepted, by time period, and at
which size tables the parties will be seated. The #in# values
indicate the size of the party and the size of table at which they
are seated. For example, “3in4” represents a party of three
seated in a 4-top, while “3in6” represents a party of three seated
at a 6-top. Note that parties are not always seated in the smallest
possible table. Looking at the results here, you will see that a
party of one would be seated in a 4-top at 19:00.
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Exhibit 12

Information by party size, for the model example
Party Size

1

2

3

4

Average Value

$25.80

$48.77

$69.86

$88.90

Average Duration (minutes)

42.00

54.00

59.00

68.00

Reservation Demand at 18:00

9

7

10

3

Reservation Demand at 18:15

8

2

11

9

Length In Periods (+0 minutes)

3

4

4

5

An Example of the Model behind the Tool
For people interested in the mathematics behind the tool, this
section presents an example of the structure of the optimization model the tool implements. In this example, I consider only
party sizes of 1 to 4 people, table sizes of 2 and 4 seats, and two
reservation times. Details on the parties are given in Exhibit 12.
Further, I assume that the restaurant has 1,800 square feet available for tables (and access) and that the 2-tops require 35 square
feet and 4-tops, 55 square feet (including access space).
I use as variables ni, representing the number of tables
with i seats; and gcpi, representing the number of reservations
accepted for parties of size c, at period p, placed in a table with i
seats. The objective, which is to maximize total value, is:
Max $25.80 * (g1,1,2 + g1,1,4+ g1,2,2 + g1,2,4)
+ $48.77 * (g2,1,2 + g2,1,4+ g2,2,2 + g2,2,4)
+ $68.86 * (g3,1,4+ g3,2,4) + $88.90 * (g4,1,4+ g4,2,4)

In words, the first part of the objective comes from the
$25.80 revenue from each party of one person and from
reservations for a party of 1 possibly being taken for a 2-top
or a 4-top for each of the two periods. The other parts of the
objective represent the values of parties of 2, 3, or 4, times the
number of appropriate reservations, with the practical limitation that parties of 3 and 4 can only be seated in 4-tops.
The first constraint imposes the limit of the size of the
restaurant:
35 * n2 + 55 * n4 ≤ 1,800

In words, the left size of the constraint calculates the total
space used by the 2-tops and adds it to the total space used by
the 4-tops, against the limitation of the restaurant’s size, on the
right.

The next set of constraints ensures that the number of
tables in use in each period, of each size, cannot exceed the
number of that size table:
[period 1, 2-tops] g1,1,2 + g2,1,2 ≤ n2
[period 1, 4-tops] g1,1,4 + g2,1,4 + g3,1,4 + g4,1,4 ≤ n4
[period 2, 2-tops] g1,1,2 + g1,2,2 + g2,1,2 + g2,2,2 ≤ n2
[period 2, 4-tops] g1,1,4+ g1,2,4 + g2,1,4 + g2,2,4 + g3,1,4+
g3,2,4 + g4,1,4+ g4,2,4) ≤ n4

As an example, in the first constraint of this set (period 1,
2-tops), reservations of both parties of 1 and 2 are summed; in
the second constraint (period one, 4-tops), reservations of all
party sizes are summed. Note that for period two (constraints
three and four), reservations that were accepted in period one
must still be considered when counting the tables in use. In this
simple example, which has only two reservation periods, no reservations disappear from the constraints, given that the shortest
dining duration exceeds two periods. If our example had four
periods then table usage in period four would not be affected
by reservations for parties of 1 taken in period one, since those
parties would have departed before period four.
The next set of constraints impose the demand limits, by
party size and reservation period:
[party size 1, period 1] g1,1,2 + g1,1,4 ≤ 9
[party size 1, period 2] g1,2,2 + g1,2,4 ≤ 8
[party size 2, period 1] g2,1,2 + g2,1,4 ≤ 7
[party size 2, period 2] g2,2,2 + g2,2,4 ≤ 2
[party size 3, period 1] g3,1,4 ≤ 10
[party size 3, period 2] g3,2,4 ≤ 11
[party size 4, period 1] g4,1,4 ≤ 3
[party size 4, period 1] g4,2,4 ≤ 9

Cornell Hospitality Tool • November 2015 • www.chr.cornell.edu • Volume 6, No. 4
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Exhibit 13

Reservations accepted in the optimal solution to the example
Period

Reservations Accepted

18:00

g1,1,2 = 0

g2,1,2 = 7

g1,1,4 = 0

g2,1,4 = 0

g3,1,4 = 10

g4,1,4 = 3

18:15

g1,2,2 = 0

g2,2,2 = 2

g1,2,4 = 0

g2,2,4 = 0

g3,2,4 = 5

g4,2,4 = 9

As an example, the first constraint in the set ensures that the
number of reservations for parties of one, taken in period 1,
and placed in 2-tops or 4-tops, does not exceed the demand of
nine parties.
The number of tables must be integers and, given the
1,800 square feet in the restaurant, there can be at most 57 twotops or 36 four-tops, limitations which are imposed as:
[2-tops] n2 = 0, 1, …, 57
[4-tops] n4 = 0, 1, …, 36
The final set of constraints, which are implicitly or explicitly defined in the demand constraints, are the integer requirements and limits on the reservations accepted by party size,
arrival period, and table size:
[party size 1, period 1, 2-top] g1,1,2 = 0, 1, …, 9
[party size 1, period 1, 4-top] g1,1,4 = 0, 1, …, 9
[party size 1, period 2, 2-top] g1,2,2 = 0, 1, …, 8
[party size 1, period 2, 4-top] g1,2,4 = 0, 1, …, 8
[party size 2, period 1, 2-top] g2,1,2 = 0, 1, …, 7

The optimal solution to this problem, which can be found using
the tool, yields an estimated daily revenue of $2,553.63. The
restaurant would use 9 two-tops and 27 four-tops. The reservations accepted are given in Exhibit 13.

Extensions
While I have presented as complex a model as can be solved in
the standard version of Solver, there are a variety of possible enhancements, if one is willing to deal with increased complexity.
For example, in a 2015 article, I evaluated models that matched
parties to specific tables, rather than the pooled-table approach
used here.1 I further offered a more sophisticated (and complex) approach to representing the variation in dining duration
compared to just inflating the dining time, which worked well
for the pooled-table models. Moreover, this tool assumes that
demand timing is fixed, whereas in reality, restaurant customers
often have the flexibility to arrive at a variety of dining times.
Incorporating demand timing flexibility is expected to increase
profitability, at the expense of a more complex, harder-to-solve
model. n

[party size 2, period 1, 4-top] g2,1,4 = 0, 1, …, 7
[party size 2, period 2, 2-top] g2,2,2 = 0, 1, …, 2
[party size 2, period 2, 4-top] g2,2,4 = 0, 1, …, 2
[party size 3, period 1, 4-top] g3,1,4 = 0, 1, …, 10

1 Gary M. Thompson, An evaluation of integer programming models
for restaurant reservations. Journal of Revenue and Pricing Management, advance
online publication June 5, 2015; doi:10.1057/rpm.2015.17.

[party size 3, period 2, 4-top] g3,2,4 = 0, 1, …,11
[party size 4, period 1, 4-top] g4,1,4 = 0, 1, …,3
[party size 4, period 2, 4-top] g4,2,4 = 0, 1, …, 9
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